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Introduction 

The adapter for Rserve was introduced in WebFOCUS Reporting Server 7708 (8.2.03), during 

the second quarter of 2018. The WebFOCUS 7708 New Features guide describes the adapter for 

Rserve as: 

 

The Adapter for Rserve enables you to define a connection to Rserve for remotely 

executing R scripts to be used with WebFOCUS reports and charts as a summary 

(Compute) or virtual field. 

Rserve is a TCP/IP server that allows users to run R scripts directly from WebFOCUS or 

the Reporting Server without the need to initialize R or link to an R library. The original 

Rserve paper is available at http://www.ci.tuwien.ac.at/Conferences/DSC-

2003/Proceedings/Urbanek.pdf. 

For more information on Rserve, see https://rforge.net/Rserve/index.html. 

 

This paper is an informal supplement to the official documentation.  It will show you how to 

install and run R, Rserve, and RStudio (optional) under Microsoft Windows How to create a 

sample R script for execution, generate its synonym, and use the R script in a WebFOCUS 

COMPUTE are covered in … 

WebFOCUS Adapter Administration  

WebFOCUS Reporting Server Release 8205  

Data Migrator Server Release 7709 

May 01, 2019 

DN4501040.0219 

Chapter 84: Using the Adapter for Rserve, page 2079 

https://webfocusinfocenter.informationbuilders.com/wfappent/pdfs5/adapteradmin7709.pdf 

 

Audience 

The primary audience for this paper is Information Builders SEs, TAMs, and QA analysts.  It 

assumes WebFOCUS Client, Reporting Server, R, and Rserve all are or will be installed on a 

single host computer, typically a laptop computer (although this configuration is not a 

requirement). 

https://rforge.net/Rserve/index.html
https://webfocusinfocenter.informationbuilders.com/wfappent/pdfs5/adapteradmin7709.pdf
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Rserve and RStat 

Rserve actually does not execute R scripts. Rserve (a server) manages connections to clients 

(the Rserve adapter is an Rserve client), starts an instance (on Unix/Linux forks a process) of the 

R interpreter for each client connection, and communicates to the R interpreter on behalf of 

the client. Rserve requests the R interpreter run the R script for the client. It is fine to say, 

"Rserve runs R scripts."  Although this is technically inaccurate, we do not want to overwhelm 

customers with unnecessary details. 

Rserve and the R interpreter must be installed on the same host computer. Rserve and the R 

interpreter do not need to be installed on the same host computer as the WebFOCUS Reporting 

Server. Rserve only needs to be visible on the network to the Reporting Server. To use Rserve 

requires beginner level R programming skills. However, we will assume you are new to R and 

will provide a sample R script and data later in this guide 

WebFOCUS RStat is a user interface for a subset of R’s features and requires no programming. A 

predictive model built in RStat is exported as a C programming language file, *.c, and then 

deployed (compiled) as a shared library (Windows .dll or Linux .so) through Developer/App 

Studio or the Reporting Server console. The shared library appears to the user as a WebFOCUS 

custom subroutine and can be used in COMPUTE, DEFINE, and Dialog manager statements.  In 

Developer/App Studio the deployed models are available in the Compute or Define dialog box > 

Functions… > Retrieve Scoring Routines.   In InfoAssist+ the deployed models are available in 

the Compute or Define dialog box > fx (Functions) > RStat Scoring Routines.  

Can an R model developed using RStat be saved as an R script to be executed by Rserve? Today, 

not easily as the RStat generated R code uses variable names and data structures that seem 

cryptic to the user.  We are evaluating a new feature for RStat, that in addition to the currently 

exported formats of .c, .c for Teradata, .java, .pmml, and .xml, will export an R script along with 

sample data and a configured Rserve adapter synonym (.acx, .msd) for the model. 

Rserve under Windows vs. Rserve under Linux 
From the Rserve documentation at http://www.rforge.net/Rserve/ 

Windows lacks important features that make the separation of namespaces possible, 
therefore Rserve for Windows works in cooperative mode only, that is, only one 
connection at a time is allowed and all subsequent connections share the same 
namespace. Briefly: don't use Windows unless you really have to.  

 

http://www.rforge.net/Rserve/
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As we just read, the Windows version of Rserve is adequate for a single user and 

demonstrations.  For multi-user installations the Linux version is mandatory. So, we have been 

warned and we know installing Rserve under Windows is fine for our needs. Let’s continue. 

Installing R 

Although an R interpreter is included with RStat, we do not recommend you use it with Rserve. 

Because of RStat software dependencies, the R version distributed with RStat is often not the 

most recent. And an Rserve user will most likely install many R packages* not relevant to RStat. 

It is best to keep separate the R interpreters for RStat and Rserve. 

* https://cran.r-project.org/web/packages/ 

 

1. In your web browser, go to https://cran.r-project.org/ 

 

2. Select “Download R for Windows” 

 
 

3. Select “base” or “install R for the first time”; they link to the same location. 

 

https://cran.r-project.org/web/packages/
https://cran.r-project.org/
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4. Select “Download R 3.6.0 for Windows.” By the time you read this document a newer 

release might be available; download the latest release.  The download will begin 

immediately. 

 
 

5. In Windows File Explorer, right-click the downloaded installation package, e.g., R-3.6.0-

win.exe, and select “Run as administrator” 

 
 

6. The first dialog appearing is 'Select Setup Language.' English is the default and, no, Klingon is 

not an option. Make a selection and click OK. 
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7. Read the GNU General Public License.  Go ahead, we'll wait.  Click Next. 

 
 

 

8. By default R will be installed in the folder C:\Program Files\R\R-3.6.0.  File paths 

containing spaces can cause problems in R, e.g., when compiling R libraries from source.  

And user downloaded and installed R packages (libraries) cannot be installed under Program 

Files due to Windows security. 

a. Let's change the default folder to C:\R\R-3.6.0.  

Using C:\R as the base folder makes it easier to manage multiple R releases installed on 

the same computer; each will be placed in a separate folder under C:\R.  This can come 

in handy for upgrading, using packages specific to an R release, etc.  On Windows, the 

most recent version installed will be recorded in the Windows registry (to be used by 

RStudio, discussed below, and Rserve). 

 

b. Click Next. 
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9. Select all options except 32-bit files. Click Next.

 
 

10. Accept the default, "No (accept defaults)", click Next.  
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11. Accept the default program's shortcuts location, R, and click Next. 

 
 

 

12. Under Additional shortcuts, select your preferences; I have checked 'Create a desktop 

shortcut.'  Under Registry entries, both items should be checked, 'Save version number in 

registry' and 'Associate R with .RData files.'  Click Next. 
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13. Wait while R is installed… 

 
 

14. When installation has completed click “Finish.” We will come back to R later. 
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Adding R to the Windows Path 
Although R's location is in the Windows registry, it is not in the system path.  Why add R to the 

Windows path? So we can start Rserve from the Windows command line. 

Let's fix that now.  

1. In the Windows File Explorer, 

a. Right-click 'This PC' 

b. Select 'Properties' from the context menu 

c. Select  'Advanced system settings' 

d. Select 'Environment variables' 

e. Select 'System variables' 

f. Select 'Path' 

g. Select 'Edit' 

h. Select 'New' 

i. Enter C:\R\R-3.6.0\bin\ 

j. Click OK three times to return to File Explorer. 
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(Okay, I got lazy and did not want to make multiple screen shots.  Simply zoom in on this 

page in Word or Adobe Reader.) 

 

2. Let's confirm we can run R. Open a new Windows CMD window, type r and press [Enter]. 

Your screen should look similar.  
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3. To exit, type q() and press [Enter]. When prompted to save the workspace image, type n 

and press [Enter]. Close the Windows CMD window.  

 

 

 

Installing Rserve on Windows Using the R Console 

We can install Rserve using the (minimal) R console or using RStudio. The R console method is 

best for users who want to install Rserve as quickly as possible and be done with it. The RStudio 

method is for those who want to delve a little deeper. The excellent, free RStudio IDE is the de 

facto standard for R development and my favorite for R coding.  We cover the R console 

method here and the RStudio method later in this document.. 

 

1. On your Windows desktop, find the R shortcut that was creating when installing R earlier in 

this document and start the R console. We are purposefully avoiding the R command line 

interface; it's a bit awkward to use.  

 
 

2. Type install.packages('Rserve') and press [Enter].  

If prompted for a CRAN mirror (download server), select a mirror close to you and click OK. 

CRAN is the public repository of R packages (libraries), the Comprehensive R Archive 

Network. 
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3. Note: the installation is very quick and due to a quirk in R, it may not display a message 

when installation has completed.  Let's see what was installed.  In Windows File explorer, 

navigate to the R library folder, e.g., C:\R\R-3.6.0. Then click on library. 
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4. We now have an Rserve folder. 

 

 

5. Open the Rserve folder and navigate to libs\x64. Copy the three files in this folder -- 

Rserve.dll, Rserve.exe, and Rserve_d.exe (do not paste yet). 
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6. Navigate up to R-3.6.0 and then down to bin\x64. Now paste the three files -- -- 

Rserve.dll, Rserve.exe, and Rserve_d.exe. 
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7. Back in the R console,  

a. Type library(Rserve)and press [Enter]  

b. Type Rserve()and press [Enter] .  

The Rserve server starts. 

 

 

8. Return to Windows File Explorer where Rserve is installed. 

a. Navigate to, e.g.,  C:\R\R-3.6.0\library\Rserve\java 

b. Copy REngine.jar and Rserve.jar. Create a new folder (without embedded 

spaces) named, say, C:\Rserve_connectors, and paste the .jar files into this 

folder. Saving these .jar files to a folder with a short file path will make configuring 

the Rserve adapter simpler.  Note the .jar files can be saved in any folder accessible 

to the WebFOCUS Reporting Server. 

 

We have completed the Rserve installation. You can exit Windows File Explorer. 
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Configuring the Adapter for Rserve 
We are now ready to configure the Adapter for Rserve. 

The WebFOCUS Adapter Administration manual* explains how to configure the Rserve adapter.  

Refer to this document to configure the Rserve adapter.  The notes below will show how to 

configure the adapter in the context of what we have done so far, e.g., installed Rserve, 

downloaded .jar files, etc. 

WebFOCUS Adapter Administration  

WebFOCUS Reporting Server Release 8205  

Data Migrator Server Release 7709 

May 01, 2019 

DN4501040.0219 

Chapter 84: Using the Adapter for Rserve, page 2079 

https://webfocusinfocenter.informationbuilders.com/wfappent/pdfs5/adapteradmin7709.pdf 

 

1. Make sure the WebFOCUS Reporting Server (8.2.03 or greater) is running. 

2. In a web browser, go to the Reporting Server web console, e.g.,  

http://localhost:8121  

3. Click the database icon to display the lists of configured and available adapters. 

 

4. Click "+ New Datasource." 

https://webfocusinfocenter.informationbuilders.com/wfappent/pdfs5/adapteradmin7709.pdf


c:\users\mcd04005\downloads\notes on using the rserve adapter.docx  18/43 

 

5. Search for "Rserve" or scroll down the page until you find it. 

 

6. Right-click Rserve and select Configure. 
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7. The screen shot below has been cropped. The settings are: 

a. Connection Name 

The choice of connection name is up to you.  In the example below we are using 

my_rserve. 

 

b. Server 

Enter the name of the host machine where Rserve is installed. We are using 

localhost 

 

c. Port 

6311 is the default Rserve port. See https://www.rforge.net/Rserve/doc.html, under 

'Configuration' for changing the port number. 

 

d. Security 

We are using Trusted to simplify configuring the Rserve adapter for demonstrations. 

See https://www.rforge.net/Rserve/doc.html, under 'Configuration' for additional 

security information. 

 

e. IBI_CLASSPATH 

Click in the edit box to move the focus (blinking cursor bar). Enter the full path and 

filename of the Rserve .jar files we had copied in step 8 of 'Installing Rserve on 

Windows.'  Each .jar file's path is entered on a separate line in the edit box. 

We had copied our files to: 

C:\rserve_connectors\REngine.jar 

C:\rserve_connectors\Rserve.jar 
 

Note: Do not remove from the edit box any existing entries.  IBI_CLASSPATH defines 

the additional Java class directories or full path .jar names which will be available for 

Java Services (all configured adapters). 

If you prefer to navigate and select the files, then click the ellipsis (three dots) to the 

right of the edit box.  

 

 

https://www.rforge.net/Rserve/doc.html
https://www.rforge.net/Rserve/doc.html
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8. We have completed the form.  Click the Configure button.  

 
 

9. The success message we receive (see below) does not indicate we have correctly configured 

the adapter, only that the configuration has been added to edasprof.prf.   

Connection my_rserve (Rserve) successfully added to configuration 

 

This is what was added to edasprof.prf: 

ENGINE RSERVE SET CONNECTION_ATTRIBUTES my_rserve 'localhost:6311'/, 

 

10. Let’s test our configured Rserve adapter. Right-click my_rserve and select Test. 
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If everything is configured properly, we will see: 
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Installing RStudio (optional) 
R is distributed with R Console, a minimal IDE (Integrated Development Environment).  Instead, 

we will use RStudio, a popular open source IDE for R. 

1. In your web browser, go to https://www.rstudio.com/ 

 

2. Select “Download RStudio.” 

 
 

3. Click “Download”, below the highlighted “FREE”, for RStudio Desktop. 

 
 

https://www.rstudio.com/
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4. The page will scroll to “Installers for Supported Platforms.” Click “RStudio 1.1.442 for 

Windows Vista/7/8/10” to download. By the time you read this document a newer 

release might be available; download the latest release.   

 
 

5. In Windows File Explorer, right-click the downloaded installation package and select 

“Run as administrator” 

 
 

6. Use the default installation location.  Click “Next.” 
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7. Use the start menu folder, RStudio.  Click “Install.” 

 
 

 

8. Wait while RStudio is installed… 
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9. When installation has completed click “Finish.” We will come back to RStudio later. 
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Installing Rserve on Windows Using RStudio 
You can install Rserve using either the R console or RStudio. 

1. Let’s start RStudio. 

Click the Windows key             on your keyboard or desktop.   Scroll down to R, open the 

RStudio folder, and select RStudio. 

 

2. Navigating RStudio 

RStudio has four panes, starting clockwise from upper left: Source (not shown), Console, 

Environment…, and Files…. All panes are configurable, under Menu > Tools > Global Options 

> Pane Layout.  We are viewing the default layout. The Console pane is R’s REPL  (Read, 

Evaluate, Print, and Loop) for typing and running R statements.  

 

 

3. Type install.packages('Rserve') and press [Enter].  



c:\users\mcd04005\downloads\notes on using the rserve adapter.docx  27/43 

 

 
 

If prompted for a CRAN mirror (download server), select a mirror close to you and click OK. 

CRAN is the public repository of R packages (libraries), the Comprehensive R Archive 

Network. 

 

4. The installation is very quick and due to a quirk in R, it may not display a message when 

installation has completed.  Our installation was successful; the message displayed is:  

package ‘Rserve’ successfully unpacked and MD5 sums checked 
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5. Let's see what was installed.  In Windows File explorer, navigate to the R library folder, e.g., 

C:\R\R-3.6.0. Then click on library. 

 

 

6. We now have an Rserve folder. 
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7. Open the Rserve folder and navigate to libs\x64. Copy the three files in this folder -- 

Rserve.dll, Rserve.exe, and Rserve_d.exe (do not paste yet). 

 
 

8. Navigate up to R-3.6.0 and then down to bin\x64. Now paste the three files -- -- 

Rserve.dll, Rserve.exe, and Rserve_d.exe. 
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9. Back in RStudio,  

a. Type library(Rserve)and press [Enter]  

b. Type Rserve()and press [Enter] .  

The Rserve server starts. 
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10. Return to Windows File Explorer where Rserve is installed. 

a. Navigate to, e.g.,  C:\R\R-3.6.0\library\Rserve\java 

b. Copy REngine.jar and Rserve.jar. Create a new folder (without embedded 

spaces) named, say, C:\Rserve_connectors, and paste the .jar files into this 

folder. Saving these .jar files to a folder with a short file path will make configuring 

the Rserve adapter simpler.  Note the .jar files can be saved in any folder accessible 

to the WebFOCUS Reporting Server. 

 

We have completed the Rserve installation. You can exit Windows File Explorer. 

Next: Continue with instructions in the section above, "Configuring the Adapter for Rserve" on 

page 16. 
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Installing RSclient for Rserve (optional) 
R libraries or modules, typically containing classes, functions, and data structures, are called 

packages.  The RSclient package contains an R client for the Rserve server. Although this step is 

optional, it is highly recommended as we will use it to verify we can start and connect to the 

Rserve server. 

1. In the RStudio console, let’s install the RSclient package.  Type   

install.packages("RSclient") and press [Enter]. A few seconds might pass 

before installation begins.  You might also be prompted to select a mirror, an alternate site 

for downloading packages from CRAN (Comprehensive R Archive Network). 

 

Communicating with Rserve (optional) 
1. If you have not already started Rserve from RStudio then let's do it now. 

Although we have installed the Rserve package, it must be explicitly loaded into the R 

session using the library() function. RStudio tip: typing [Ctrl]+l (the letter el) when 

in the Console pane will clear all text from the pane. When typing, remember R is case 

sensitive. No error message means the library loaded successfully 

a. Type library(Rserve)and press [Enter]  

b. Type Rserve()and press [Enter] .  

The Rserve server starts. 
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2. Let’s load the RSclient package and then connect to Rserve. Enter the following two lines 

into the Console. Press Enter after each line. 

library(RSclient) 

conn <- RS.connect() 

 

 

In the R code above, the two character symbol <- is the assignment operator.  Although 

R also recognizes = as the assignment operator, = does not work as expected in some 

corner cases, so it is best to always use <-.   

RS.connect() is the RSclient function for creating a connection to the Rserve 

server.  
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3. Let’s add two numbers. Enter the following two lines into the Console. Press Enter after 

each line. 

result <- RS.eval(conn, 4 + 5) 

result 

 

 

In the R code above, we store the result of the calculation 4 + 5 in the variable 

result. The function RS.eval(), performs  R  statement  evaluation through Rserve 

and requires as its first argument the name of  the Rserve connection, conn, we 

defined  in the previous step,. 

When using R in interactive mode, i.e., not running a script, simply typing the name of a 

variable, e.g., result, will display its value. We’ll ignore the “[1]”; it refers to the first 

item in result, a vector (R has no scalars).  

Next: Continue with the section "Shutting Down Rserve" 

 

Shutting Down Rserve 

 

Remember at the beginning of the document when we read "… the Windows version of Rserve is 

adequate for a single user and demonstrations?" This means, under Windows, if an Rserve 

client, say, using the RSclient package in RStudio, has a connection to the Rserve server, and if  

another client, say, the WebFOCUS Adapter for Rserve, tries to connect to the Rserve server, 

then this other client, our WebFOCUS Adapter for Rserve, will be locked out. This can cause 

extreme aggravation.  Let's see what this looks like, being locked out, not the extreme 

aggravation. 

Let's test our my_rserve connection. 
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A few seconds will pass and the dialog box “Executing server request” might appear. Let’s wait 

a bit… Forty-two seconds have passed! Why so long for the WebFOCUS Reporting Server to 

connect with the Rserve server?  I just remembered – we installed the Windows version of 

Rserve and it is single user.  The single connection is being used (and locked) by our RStudio 

session. Leave the dialog box open. 

 
 

Let’s kill the RStudio session connection to Rserve.  Switch over to RStudio. As a reminder how 

we created the connection, the statements are repeated below.  The variable containing the 

connection is conn.  
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Type the statement RS.close(conn) and press Enter. 

 

 

The returned NULL indicates the connection has been closed. But Rserve is still up and running, 

Switch over to the open WebFOCUS Reporting Server in the web browser. As soon as we closed 

the Rserve connection in RStudio our WebFOCUS Reporting Server’s connection request 

through the Rserve adapter succeeded. The message is “Successful test for the connection 

my_rserve: R version 3.4.4 (2018-03-15)."  Note, your "success" message might be different, 

depending on the Reporting Server version. 

 

 
 

That was frustrating but we solved the problem.  But what if, somehow, some other process 

has locked us out of Rserve and we cannot find the connection so we can close it? Then we shut 

down Rserve. 

 

Rserve has no shut down button. We'll prove it. 

Let's start Rserve from the Windows command line.  I'll explain the Rscript program later, in the 

section Starting Rserve. 
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Let's start Windows Task Manager.  Press [Ctrl]+[Alt]+[Delete]. Select 'Task 

Manager.' 

In the Processes tab, under Apps, look for Windows Command Processor and expand it (it 

might be follow by a number in parentheses).  Below it we see Rserve.exe. 

Back in the Windows Command Prompt window, press [Ctrl]+C.  Notice Rserve does not 

seem to be running.  
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Back to Task Manager.  From the menu bar, select View > Refresh now.  Rserve is still running. 

 

 
 

Close the Windows Command Prompt window. Go back to Task Manager and do View > 

Refresh Now. We see Rserve has stopped running; it does not appear under Apps. But closing 

the Windows Command Prompt does not reliably shut down Rserve.  Continue reading to learn 

how to shut down Rserve using the Windows Task Manager (after a brief look at RStudio). 
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But what if we had started Rserve from RStudio?  Will exiting RStudio shut down Rserve? Let's 

see. Starting Rserve in RStudio… 

 
 

Let's check in Task Manager. Under Apps expand RStudio and we see Rserve.exe running. 
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Exit RStudio (menu bar > File, Quit Session), return to Task Manager, do View > Refresh now. 

RStudio and Rserve do not appear under Apps. 

 
But scroll down enough or repeatedly press the R key and we will see Rserve.exe is still running. 

To shut down Rserve.exe, click Rserve.exe and then click the End task button in the lower right.  
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Starting Rserve 
It's not practical to start the R console or RStudio simply to run Rserve.  Open a Window Command 

Prompt window (cmd.exe),,  type the statement below and press [Enter] 

Rscript -e library(Rserve);Rserve() 

This statement can also be used from a Windows batch (.bat) or command (.cmd) file. 

Rscript.exe is the recommended method for running R scripts in batch mode. We can also run 

an R statement using the -e option. Remember R is case sensitive, a semicolon separates 

statements, and do place  any embedded spaces immediately before or after any semicolons or 

the statement(s) will fail to execute. 

 

 

To view Rscript's help file, type Rscript and press [Enter]. 
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Building a Predictive Model in R  

Creating a Synonym for the Predictive Model 

Using the Synonym (Predictive Model) in a WebFOCUS Report 
The above three topics are covered in depth in: 

WebFOCUS Adapter Administration  

WebFOCUS Reporting Server Release 8205  

Data Migrator Server Release 7709 

May 01, 2019 

DN4501040.0219 

Chapter 84: Using the Adapter for Rserve, page 2079 

https://webfocusinfocenter.informationbuilders.com/wfappent/pdfs5/adapteradmin7709.pdf 

 

I wrote this chapter with an Information Builder's technical editor, so I know it's accurate. If you 

want the source code send me an email: ira_kaplan@ibi.com 

https://webfocusinfocenter.informationbuilders.com/wfappent/pdfs5/adapteradmin7709.pdf

